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ICONICS LICENSE AGREEMENT

YOU SHOULD CAREFULLY READ THE FOLLOWING
TERMS AND CONDITIONS!

Opening and using the enclosed software for any purpose indicates your
acceptance of the terms and conditions of this license agreement. If you do not
agree with them you should return all software, documentation and copy protection
keys within seven days of shipment unopened and your money will be refunded.

ICONICS provides this program and licenses its use in the United States, Puerto
Rico, or internationally. You assume the responsibility for the selection of the
program to achieve your intended results, and for the installation, use and results
obtained from this program.

LICENSE

You are granted a personal license to use this program under the terms stated in
this Agreement. You may: 1) Install and use the program on a single machine;
and 2) make a single archival back-up copy of the program for the sole purpose of
supporting your use of the single program on a single machine. You may not
copy, translate, modify or adapt the program, or any portion thereof, or incorporate
it, in whole or any part, in any other product, create derivative works based on the
program, or any portion thereof, or license others to reproduce any copies of the
program, or any portion thereof, and you may not decompile, disassemble or
reverse engineer the program, or any component thereof except as permitted by
law, and then only after having prior requested in writing from ICONICS any
interoperability information you are attempting to obtain.

TERM
The license is effective until terminated. It will terminate if you fail to comply with
any term or condition of this Agreement. You agree, upon such termination, to
destroy the program and all copies that were made from it and to promptly return
any copy protection key(s) to ICONICS.

LIMITED WARRANTY

ICONICS WARRANTS THE CD-ROM, DVD OR PHYSICAL DISKETTES, ON
WHICH THE PROGRAM IS FURNISHED, AND PHYSICAL DOCUMENTATION
TO BE FREE OF DEFECTS IN MATERIALS AND WORKMANSHIP UNDER
NORMAL USE FOR A PERIOD OF NINETY (90) DAYS FROM THE DATE OF
DELIVERY TO YOU AS EVIDENCED BY YOUR RECEIPT. THIS PROGRAM IS
PROVIDED “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESSED OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE IMPLIED
WARRANTIES OF TITLE, NON-INFRINGEMENT, MERCHANTABILITY OR
FITNESS FOR A PARTICULAR PURPOSE. THE ENTIRE RISK AS TO THE
QUALITY AND PERFORMANCE OF THE PROGRAM IS WITH YOU. SHOULD
THE PROGRAM PROVE DEFECTIVE, YOU ASSUME THE ENTIRE COST OF
ALL NECESSARY SERVICING, REPAIR, OR CORRECTION.

ICONICS it
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ICONICS SPECIFICALLY DISCLAIMS ALL OTHER WARRANTIES,
EXPRESSED OR IMPLIED, INCLUDING BUT NOT LIMITED TO, IMPLIED
WARRANTIES OF TITLE, NON-INFRINGEMENT, MERCHANTABILITY AND
FITNESS FOR A PARTICULAR PURPOSE. IN PARTICULAR, WITH RESPECT
TO ANY PARTICULAR APPLICATION, USE OR PURPOSE, IN NO EVENT
SHALL ICONICS INC. BE LIABLE FOR ANY OTHER COMMERCIAL DAMAGE,
INCLUDING BUT NOT LIMITED TO SPECIAL, INCIDENTAL, CONSEQUENTIAL
OR OTHER DAMAGES. ICONICS DOES NOT WARRANT THAT THE
FUNCTIONS CONTAINED IN THE PROGRAM WILL MEET YOUR
REQUIREMENTS OR THAT THE OPERATION OF THE PROGRAM WILL BE
UNINTERRUPTED OR ERROR FREE.

LIMITATION OF REMEDIES

ICONICS’ entire liability and your exclusive remedy shall be the replacement of any CD-
ROM, DVD or diskette not meeting ICONICS’ “Limited Warranty” which is returned to
ICONICS with a copy of your receipt within the warranty period. The remedy for breach
of this warranty shall be limited to replacement and shall not encompass any other
damages including but not limited to loss of profit, special, incidental, consequential, or
other similar claims arising out of the use or inability to use such program even if
ICONICS has been advised of the possibility of such damages, or for any claim by any
other third party.

GENERAL
This Agreement will be governed by the laws of the Commonwealth of Massachusetts.
Should you have any questions concerning this Agreement, you may contact ICONICS
in writing at:

ICONICS, Inc.
100 Foxborough Boulevard
Foxborough, MA 02035

You acknowledge that you have read this Agreement, understand it and agree to be
bound by its terms and conditions. You further agree that it is the complete and exclusive
statement of the Agreement between you and ICONICS which supersedes any proposal
or prior Agreement, oral or written, and any other communications between you and
ICONICS relating to the subject matter of the Agreement.

ICONICS RETURN POLICY
All sales are final (NO RETURNS) unless one of the following conditions is applicable:
Program is returned in its original packaging material within 7 days after shipment. In
such a case, a full refund is provided, less all incurred shipping and handling costs.
Program is returned within 30 days from the original shipment date. In such a case a
20% restocking fee is applicable. No returns are allowed on OPC ToolWorX or ActiveX
ToolWorX. All returns must have an appropriate RMA number.

EXPORT COMPLIANCE
You agree to comply with the United States of America’s current Export Administration
Regulations (EAR) and agree that you will not distribute or supply this product in violation
of the EAR. You are responsible for securing any export approval or license as may be
needed under the EAR. Additionally, you are responsible for obtaining local customs
clearance as applicable and paying all duties, taxes and other charges.

iv ICONICS



GENESIS64 Getting Started Table of Contents

TABLE OF CONTENTS
1 GENESIS64 OVERVIEW 1-1
1.1 INTRODUCTION ....ocuieiieuieuienienieienteseestessessesseeseeseeseeseessensensensessessansenss 1-1
1.2 WHAT IS GENESIS64? . 122
1.3 WHAT IS OPC UA?.....oiiieieeeeteeteeeeeee e 1-2
2 SYSTEM REQUIREMENTS 2-1
3 INSTALLING GENESIS64 3-1
3.1 STARTING THE INSTALLATION PROCESS .....ccceeieieieieieienienenieneeaes 3-1
3.2 TYPICAL INSTALLATION
3.3 CUSTOM INSTALLATION .
3.4 UNINSTALLING GENESISO4 ........cooiiiiiiniiieseeeeeeeeeeene 3-14
4 ICONICS SOFTWARE LICENSING 4-1
4.1 SOFTWARE AND HARDWARE KEYS......ccccveiiiiierieieieieiesieere e 4-1
4.1.1 Software Licensing .
4.1.2 Hardware Key .............cccooeeiiineiniiieieeeeee s
4.2 LICENSE UTILITY ..eovtetietieuienieiesietessessestesseeeeseeseessessessessessessessessessenns

4.2.1 Running the License Utility .
4.2.2 License File...........ccccoociiioiiiiiiiiiiieeccctee e
4.2.3 Activating the 30-day Trial/Emergency License.......................... 4-3
4.2.4 Killing a Software Key License .
4.3 LICENSE VIEWER ....ccooiiiiiiiiiiiiciciisines st
4.4 WEB LICENSING.......ccoiuimiiiiiiiiiiicinieiieissinec s
4.4.1 Acquiring a New Software License
4.4.2 Adding to an Existing Software License................ccccoccevneun.. 4-18
4.4.3 Upgrading a Software License Key .............ccccccccoceievvcccnnn.
4.4.4 Upgrading a Hardware Key License ...
4.4.5 Licensing the New Version.............cccocucueceeevensceneccreeneenns
4.5 CLOUD LICENSING......ceoeuiiiiiiiiiicinieiiiisinec s
4.5.1 How Cloud Licensing Works..
4.5.2 Issuing a New Cloud License.
4.5.3 Activating the License................
4.5.4 Adding an Existing Cloud License...
4.5.5 Killing a Cloud License.............
4.6 DEMO MODE ..ot s

5 GENDEMO 5-34

5.1 INTRODUCTION ....ootietietieuierienienieneeseesiensensessessensessessesseesesseeseessessesens 5-34

ICONICS v



Table of Contents GENESIS64 Getting Started

6

5.2 GENDEMO OPTIONS .....ccouerierierieniiriennenne .. 5-35
5.3 INDUSTRY CASE STUDIES AND EXAMPLES ........ccoovveuieienienieieiennns 5-35

GENESIS64 QUICK START 6-1
6.1 INTRODUCTION ....octieiieiieuienienienieteniententessessesseesesseeseeneensensensensensensesaes 6-1

6.2 GRAPHWORX64 ..
6.3 ALARMWORX64 .
6.4 TRENDWORX64 ..

6.5 EARTHWORX... ..6-3
6.6 GRIDWORX ..... .. 6-3
6.7 WORKBENCH ......coeevvirerriiereenennnn ..6-3
6.8 ADDITIONAL TOOLS AND UTILITIES .6-4

7 HELP AND TECHNICAL SUPPORT 7-6
7.1 HELP DOCUMENTATION ....eoiiiieienieienieniesieeteeseeneeseensensensensessensensenaes 7-6
7.2 PRODUCT VIDEOS........ .7-6
7.3 TRAINING CLASSES..... .. 7-6
7.4 TECHNICAL SUPPORT................ 77
7.4.1 Global Support and Services.. .77
7.4.2 Customer Connection Portal . L 7-7
7.4.3 Telephone SUPPOFL.............ccoeveueucvinirieeeieeteseeee e 7-8

vi ICONICS



1 GENESIS64 OVERVIEW

1.1 Introduction

Welcome to ICONICS GENESIS64™, a powerful, 64-bit,
Web-enabled, OPC HMI/SCADA suite. GENESIS64 takes
full advantage of the convergence of 64-bit-based computing
machinery, the release of new Microsoft operating systems
and the growing customer demand for engaging three-
dimensional graphic visualization of business processes.

GENESIS64 includes several solutions that allow for
connectivity from the plant floor to corporate business
systems to provide a 360-degree view of an entire
organization. It was designed from the ground up to utilize
new Microsoft technologies including:

Microsoft.NET

Windows Presentation Foundation (WPF)

3D Hardware-accelerated Visualization

Windows Communication Foundation (WCF)
OPC Unified Architecture (OPC UA)

Windows User Access Control (UAC) Persistence
Windows Search and Organize

Windows Multitouch

Microsoft Bing™ Maps

ICONICS GENESIS64 suite is comprised of the following products:

GraphWorX™e64
AlarmWorX™64
TrendWorX™e64
EarthWWorX™
AssetWorX™
GridWorX™
FDDWorX™
ScheduleWorX™e64
Workbench™
WebHMI
ReportWorX64
ReportWorX Express
ReportWorX 365
RecipeWorX

ICONICS
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AlertWorX
KPIWorX
System Health
Data Explorer
This Getting Started manual explains how you can:
. Install the GENESIS64 software.
. Familiarize yourself with and start using the

Workbench multi-functional, centralized Web-
based environment

. Access online help and technical support.

Note: This manual is an abbreviated version of the full
GENESIS64 Help documentation, which is available in the
GENESIS64 Product help.

1.2 What Is GENESIS64?

GENESIS64 is a suite of tools that you can use to create
state display and control software for equipment, machinery,
or devices that use the OPC open process control standards
of the OPC Foundation. OPC standards exist for both real-
time data, alarms, and events, as well as for historical data
that can be logged and replayed at a later date.

1.3 What Is OPC UA?

OPC is a standards-based approach for connecting data
sources (e.g., PLCs, controllers, 1/O devices, databases, etc.)
with HMI client applications (graphics, trending, alarming, etc.).
It enhances the interface between client and server
applications by providing a universally supported and well-
documented mechanism to communicate data from a data
source to any client application. Included are not only a
detailed guide on how to pass the data, but also specific
information on other attributes to supplement those data, such
as range information, data type, quality flags, and date and
time information.

OPC UA or "Unified Architecture" unites legacy OPC
standards such as OPC-AE (Alarm & Events), OPC-DA
(Data Access), and OPC-HDA (Historical Data Access) into
one complete specification.

1-2
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The GENESIS64 automation suite supports these legacy
protocols transparently, which incorporates newer
communication standards while retaining backwards
compatibility.

Any OPC client application can connect to any OPC server.
In other words, OPC offers true Plug-and-Play capability in
the fields of HMI and industrial automation. OPC server
types include OPC Data Access (DA), OPC Alarm and
Events (AE), and OPC Historical Data Access (HDA).

ICONICS
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2 SYSTEM REQUIREMENTS

Before installing any products please make sure you have
the correct prerequisites installed.

ICONICS Suite

ICONICS advanced visualization, productivity, and
sustainability solutions are built on its flagship products:
GENESIS64™ HMI/SCADA, Hyper Historian™ plant
historian, AnalytiX® solution suite and MobileHMI™ mobile
apps. ICONICS is leading the way in cloud-based solutions
with [oTWorX™  which helps customers embrace the
Internet of Things (loT) and Industry 4.0. This end-to-end
software solution provides remote cloud monitoring and
analytics via low-cost loT gateway devices. Delivering
information anytime, anywhere, ICONICS solutions scale
from the smallest standalone embedded projects to the
largest enterprise applications.

ICONICS System Requirements vary between:
. Minimum Requirements
. Medium-powered Requirements
. High-powered Requirements

ICONICS
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System Requirements - Minimum Requirements

CPU

Dual Core 64-bit processors (e.g., AMD Athlon 64 X2, Intel
Xeon, and AMD Phenom)

Memory
4 GB of RAM is required (6 GB Recommended)

Note: It is recommended that the system page file size be a
minimum of four (4) times the size of installed (physical)
RAM.

Note: It is recommended that the virtual memory allotment
be two times the amount of physical memory (RAM) on the
system.

Hard Disk

At least 4 GB free hard disk space is required (10 GB
Recommended)

Drive
DVD Dirive for Installation

Video Card

Onboard Video Memory (256MB) Display resolution
minimum - 1024x768, 32-bit color

DirectX 9 or 10 Video Card or better

Operating System
e  Windows 10 x64 (Pro or Enterprise Edition)
e  Windows 8.1 x64 (Pro or Enterprise Edition)

e  Windows 7 SP1 x64 (Professional or Enterprise
Edition)

. Windows Server 2019
. Windows Server 2016 x64

2-2
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Windows Server 2012 R2 x64
Windows Server 2012 x64

Note: Windows 10 Anniversary Update is required for
MobileHMI UWP app.

Note: Server-class operating system highly recommended
for web hosting and AnalytiX features.

.NET Framework
Microsoft .NET Framework 4.7.2

Web Server/Access

Microsoft Internet Information Services (11S) 7.0 or higher

Edge, Internet Explorer,Firefox, Safari, or Chrome

SQL Server

Microsoft SQL Server 2019
Microsoft SQL Server 2017
Microsoft SQL Server 2016
Microsoft SQL Server 2014
Microsoft SQL Server 2012 R2

The connection to SQL Server data source may
be either local or remote.

ICONICS supports SQL databases with
encryption.

ICONICS
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System Requirements - Medium-powered Requirements

CPU

Quad Core 64-bit processors or better (e.g., AMD Athlon 64
X2, Intel Xeon, and AMD Phenom)

Memory
8 GB of RAM or higher
Note: It is recommended that the system page file size be

a minimum of four (4) times the size of installed (physical)
RAM.

Note: It is recommended that the virtual memory allotment
be two times the amount of physical memory (RAM) on the
system.

Hard Disk

At least 4 GB free hard disk space is required (10 GB
Recommended)

Drive
DVD Dirive for Installation

Video Card

Onboard Video Memory (500MB) Display resolution
minimum - 1024x768, 32-bit color

DirectX 9 or 10 Video Card or better

Operating System
e  Windows 10 x64 (Pro or Enterprise Edition)
e  Windows 8.1 x64 (Pro or Enterprise Edition)
. Windows 8 x64 (Pro or Enterprise Edition)

. Windows 7 SP1 x64 (Professional or Enterprise
Edition)

24
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Windows Server 2019
Windows Server 2016 x64
Windows Server 2012 R2 x64
Windows Server 2012 x64

Note: Windows 10 Anniversary Update is required for
MobileHMI UWPapp.

Note: Server class operating system highly recommended
for web hosting and AnalytiX features.

.NET Framework
Microsoft .NET Framework 4.7.2

Web Server/Access

Microsoft Internet Information Services (11S) 7.0 or higher

Edge, Internet Explorer, Firefox, Safari, or Chrome

SQL Server

Microsoft SQL Server 2017
Microsoft SQL Server 2016
Microsoft SQL Server 2014
Microsoft SQL Server 2012 R2
Microsoft SQL Server 2008 R2 SP1

The connection to SQL Server data source may
be either local or remote.

ICONICS supports SQL databases with
encryption.

ICONICS
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System Requirements - High Powered Requirements

CPU

Quad Core 64-bit processors or better (e.g., AMD Athlon 64
X2, Intel Xeon, and AMD Phenom)

Memory
16 GB of RAM or higher
Note: It is recommended that the system page file size be

a minimum of four (4) times the size of installed (physical)
RAM.

Note: It is recommended that the virtual memory allotment
be two times the amount of physical memory (RAM)

on the system.

Hard Disk

At least 4 GB free hard disk space is required (10 GB
Recommended)

Drive
DVD Dirive for Installation

Video Card

Onboard Video Memory (1GB) Display resolution minimum -
1920x1080, 32-bit color

DirectX 9 or 10 Video Card or better

Operating System

Windows 10 x64 (Pro or Enterprise Edition)

Windows 8.1 x64 (Pro or Enterprise Edition)

Windows 8 x64 (Pro or Enterprise Edition)

Windows 7 SP1 x64 (Professional or Enterprise Edition)
Windows Server 2019

2-6
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Windows Server 2016 x64
Windows Server 2012 R2 x64
Windows Server 2012 x64

Note: Windows 10 Anniversary Update is required for
MobileHMI UWP app.

Note: Server class operating system highly recommended
for web hosting and AnalytiX features.

.NET Framework
Microsoft .NET Framework 4.7.2

Web Server/Access
Microsoft Internet Information Services (IIS) 7.0 or higher

Edge, Internet Explorer, Firefox, Safari, or Chrome

SQL Server

Microsoft SQL Server 2017
Microsoft SQL Server 2016
Microsoft SQL Server 2014
Microsoft SQL Server 2012 R2
Microsoft SQL Server 2008 R2 SP1

Notes:

1. The connection to SQL Server data source may
be either local or remote.

2. ICONICS supports SQL databases with
encryption.

ICONICS
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NOTE: The requirements described above are based on
typical applications. Depending

on your specific application, the minimum requirements may
vary.

Optional Hardware
. Ethernet adapter, WiFi card, or cellular 3G/4G
. USB port (for hardware license)
. Serial COM ports or other adapters (for data I1/O)

Uninstalling

It is recommended by ICONICS to use Add/Remove
Applications from Control Panel to uninstall the applications.
Since applications are registered in the registry,
Add/Remove uninstalls the product and makes the required
registry changes for you.

If you uninstall some common components that are used by
the product, you may be required to register those
components again or simply reinstall the product.

NOTE: Do not delete the files and directories manually;
doing so will leave the registry entries intact and interfere
with future installations. Please use the uninstall feature of
the operating system!

2-8 ICONICS



3 INSTALLING GENESIS64

The following steps detail the GENESIS64 system
installation.

GENESIS64's installation uses a standard InstallShield
installer to provide you with options for installing
components, adding new or existing users, configuring the
database engine that you use and the size of the tables that
are created, and more.

Warning: Prior to installation, verify that the system meets
minimum hardware and software requirements, as described
in the System Requirements section. Installation will abort if
the minimum requirements are not met.

Note: You cannot install any 10.8x and later product from
Remote Desktop when using a shared drive. In such
instances, it is suggested that you copy the installation's
sources to a local drive or share the drive via Windows
networking rather than via Remote Desktop.

Important Note: Uninstall previous versions of
GENESIS64 before installing the latest version of
GENESIS64.

3.1 Starting the Installation Process

Note: Installations of Internet Information Services differ
depending on the operating system, but can be found in the
Server Manager under Roles in Windows Server 2012 or
later and should be turned on.

To Install GENESIS64:

1. Insert the installation DVD into your optical drive.
The installer opens if auto start is operating
correctly. If not, open the DVD drive window and
double-click the Default.hta file icon. Select
“GENESIS64 Installation”. The Prerequisites
Installer Dialog appears.

2. Choose ‘Install’. This installs everything needed
for running GENESIS64. If you don’t have SQL
Server 2018 installed locally, you are prompted to
install it. (You can choose No if you plan on using
an older version of SQL Server, or you are going
to use remote SQL Server).

ICONICS
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The ICONICS GENESIS64 — InstallShield
Wizard window appears.
3. Click on the Install Button

«  ICONICS Suite requires the following items to be installed on your computer, Click Install
}[ to begin installing these requirements.

Status | Requirement

Instaling System Check

Pending  Preparing System

Pending  SQL Server Check

Pending  OPC UA Local Discavery Server 1,02

Installing System Check

A message appears that reads, ICONICS
GENESIS64 installation requires a reboot.’

4.  Click the Yes Button.

= ICONICS GENESIS64 requires the following items to be installed on your computer. Click
’ Install to begin instaling these requirements.

Status  Requirement
Instaling System
Pending  Preparir|
Pending  SQL Ser
Pending OPC LA

ICONICS GENESISE4 - InstallShield Wizard

The installation of ICONICS GENESIS64 requires a reboot. Click Yes to
restart now or No if you plan to restart later,

Installing System Check

Instal Cancel

After restart, the ‘User Account Control’ window appears.

3-2 ICONICS
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5. Click the Yes Button to continue the installation.

User Account Contral X

Do you want to allow this app to make
changes to your device?

’i setup

Verified publisher: ICONICS
File origin: Hard drive on this computer

Show more details

Yes No

6. In the Welcome Dialog, click the Next button to
view the License Agreement step.

GENESIS64"

ICONICS GENESIS84 x

" GENESIS64°

2 | o
» iCTNIES | ‘oues ne
e foi

7. Read the License Agreement.

8. If you agree to the terms and conditions, click the
“l accept the terms of the license agreement”
radio button.

ICONICS 3-3
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9. Click the Next button to continue.

ICONICS Suite - InstallShield Wizard X
ICONICS Suite )
> ICONICS
=
ICOMICS LICENSE AGREEMENT ~

Y0OU SHOULD CAREFULLY READ THE FOLLOWING TERMS AND CONDITIONS!
Opering and using the enclased software for any pupose indicates your aceeptance of the tems
and condiions of this icanss agresment. | you do not agres with them you should return all
software, documentation and capy protection keys within seven daps of shipment unapened and
ot maney vill e refurded.

ICOMICS providss this program and licensss its use in the Urited States. Pueta Rico, or
intemationaly, You assume the 12spansibilty far the selection of the progiam to achiewe your
intended resuils, and for the installalion, use: and resuls obtained from this program

LICENSE
You are granted a personal license to use this program unde the terms stated i this Agreement

‘You may: 1) Install and uss the program on & single machine; and 2) make a single archival

back-up capy of the program for the sole purpase of supparting pour use of the single pragraman .

(Ol accept the terms of the license agresment Print
(@) | do rot accept the termes of the license agreement

Visit the ICONICS Website

< Back Next > Cancel

10. In the Setup Type Dialog, select the type of setup
you wish to perform: Typical or Custom.

. Typical installation installs most of the
components of GENESIS64.

e  Custom installation allows you to choose the
components to be installed.

Since the Setup procedure varies slightly depending on
the installation type you choose, the installation of each
is described fully in the two sections that follow. Refer
to “Typical Installation” on the next page or “Custom
Installation” later within this section.

3-4 ICONICS
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3.2 Typical Installation

Typical installation is intended to install all of the
GENESIS64 applications and tools. It creates all of the
supporting databases as necessary.

You need to provide the correct database connection and
logon information. Once those steps are completed, the
installation does not require as much of your attention.

If you are installing GENESIS64 on a system that has a
previous version of ICONICS products already installed,
uninstall the older version before installing GENESIS64. If
you have uninstalled a previous version, Setup leaves the
database files intact on your system for you to use at a
future date. Typical installation asks you if you want to
overwrite or leave the supporting database files.

To perform a typical installation:

1. Click the Typical radio button in the Setup Type dialog
box described above. Setup evaluates your system for
compliance with the requirements, and then posts a
confirmation dialog box.

ICOMNICS Suite - InstallShield Wizard X
ICONICS GENESIS64 ’ ’_cﬂ/”,-ﬁ?s
=

Click the type of sstup you prefer, then click Next

® Typical
Frogram vill be: installed with the mast common optians. Rrecommended for most

() Custom

*You may sslect the options you want to install. Fecommended for advanced users

< Back Cancel

2. The Logon Information screen appears. Enter the
requested user name/password info. hen click Next.

ICONICS
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Note: From the Logon Information Dialog, you can
choose to use either a local machine account or a
domain security account, as well as create a new user
or use an existing user account.

ICONICS Suite - InstallShield Wizard X
ICONICS Suite "
» ICONICS
&

Specity the user aceount to be used by this application. User aceounts must be in the format
DOMAINSUssmame,

User name:

‘hdm\n

Browse.

Password:

Select the bulion below to specify information about a new user that wil be
created duting the installation

Mew User Information.

<Back Cancel

3.  Clicking Next brings up the Database Server
Dialog. Here you can select local or remote database
together with database settings and the authentication
that server database is secured under.

4.  Click Next. At this time, additional components are
installed automatically.

ICONICS Suite - InstallShield Wizard x
Database Server -
Select dalabase server and aulhenication method. » ICONICS
=

Database server that you are instaling to:

lioca] o | Bawse.

Comnect Using: Databases Creation
(® windows authentication [ Use Astive Databasss
(O 50L Server authentication [ Silent Canfiguration
LogniD:  ca Include ol Samples
Passord [ Overwrite all Databases
Upgrade 2l Configurations
Use Unified Database
Enable Project Reporting [utomaticaly) Unified D atabase Mame:
AL | | [teebinifzdCentia

<Back Cancel
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Use Active Databases — Databases from previous
installation of Genesis64 will be attached to this
installation

Silent Configuration — Databases will be installed
with selected setting and there won’t be additional
dialog with advanced database setting

Include all Samples — Install sample data that you can
experiment with

Overwrite all Databases — Overwrite older Databases
Upgrade all Configurations — Automatically update all
configurations to their most recent version

Use Unified Database — Install all configuration in one
unified database

Enable Project Reporting — Enable and setup Project
Reporting on SQL server if possible (Project Reporting
is supported on SQL 2008 R2 and higher)

When the ICONICS GENESIS64 - InstallShield Wizard
window pops up , click on the Install Button

ICONICS Suite - InstallShield Wizard X
ICONICS Suite |
» ICONICS
=

Click Install to begin the installation.

If you want to review or change any of your installation settings, dick Back. Click Cancel to
exit the wizard.

< Back Install Cancel

ICONICS
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5.

6.
7.

The System Setup Dialog will now appear. You can
either leave the Include all samples checkbox enabled
(in order to install sample data that you can experiment
with) or disable this checkbox to install blank tables.
Advanced configuration will allow settings for additional
sizing options on the database and log files. You can
enable Unified database (one database that contains all
the configurations) and also you can enable Overwrite
all (overwrite all existing databases), or you can use
Upgrade automatically all database configurations
(existing databases will be automatically upgraded to
the newest version).

R system Setup - o x

lcoUnifie i r

Database Pref

Include samples n ll configuratons
] Overwrite sl cor -
Automatically upe

configurations

Setup Database: | Icosetup Inta ize: 2, Mavimum Size: 100 Growth: 1, Log Sze: 1 [ | [ Overwrite

Avalable Configurations

AlertWorx

Assets
BACnet

om0~
oooooo
[ESHSESHEEA]

Bl Server

Gt
Click the Install button to continue the installation.

After completing the installation, the Wizard Completed
dialog box appears. Click the Finish button.

ICONICS Suite - InstaliShield Wizard
InstallS hield Wizard Complete

The InstallShisld Wizard has successtull installed IONICS Sute.
fore you Can use the program, you must restar your computer

Thank you @ Vee, | want (o restart my computer now;

for choosing () Mo, | will iestant my compter later
ICONICS Software

> imﬁs
&

<Back Cancel

3-8
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Note: It is recommended that you restart your system,
although not required.

If the installation seems to hang, check to see that there are
not any alert boxes posted that require dismissal prior to
completing the installation.

3.3 Custom Installation

Custom installation varies slightly from the Typical/Complete
installation in that you select the components you wish to
install.

1. Select the Custom installation Setup Type.

ICOMICS Suite - InstallShield Wizard *

> icﬁ’??:s
=

ICONICS GENESIS64

Click the type of setup you prefer, then click Nest.

O Typical
Program will be installed with the mast commen options. Recommended for most

(®) Custom
“You may select the options you want ko install. Recommended for advanced users

< Back Cancel
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2. You will then be prompted to select the
Destination Location. Specify the destination by
selecting Browse, or select Next if the default
location is correct.

ICONICS Suite - InstallShield Wizard x
ICONICS GENESIS64 .
» ICONICS
=

Setup wil install ICONICS Suite in the following folder.

Toinstall to this folder, dick Next. To install to a different folder, dick Browse and select
another folder.

Destination Folder

€:VProgram Files\ICONICS\GENESIS4, Browse...

prees o=

3.  Click the checkboxes to install your selected

components.
ICONICS Suite - InstallShield Wizard x
ICONICS GENESISB4 .
=
“ Suite Dptions
£ [AServer
Platform Services GENESISE4
Application Servers [ MobileH1
web Appiications
Converteriard Eeiba
=-FA Cliert [ AlarmiwioixG4 b
Cliert Comman
Graphwoi ] Huper Histarian
[Vigwers for Graphiwont [ Quality Analyti
Symbol Library .
Phone Templates [ Facility Analyti.
Flepartwoi< Express
[ATemplates
[AWorkbench Client .
U0 it st M ik b srmrese 33968 of space required o the C dive
Select All | | Deselect Options 9353 GB of space available on the C drive

<Back Cancel
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Click Next and specify the user account to be
used by this application.

ICONICS Suite - InstallShield Wizard x
ICONICS Suite )
> ICONICS
=4
Specily the user account to be used by this applisation. Lser accounts must be in the format
DOMAIN e,
User name:
[famin | | Browse

Password:

Select the button below to specity information about a new user that wil be
created during the installation

News Uzer Infarmation...

<Back Cancel

Click the Next button to continue the installation.

In the Database Server Dialog you can select local
or remote database together with database
settings and authentication that is the database
server secured under.

. Use Active Databases — Databases from
previous installation of Genesis64 will be
attached to this installation

e Silent Configuration — Databases will be
installed with selected setting and there won’t
be additional dialog with advanced database
setting

¢ Include all Samples — Install sample data
that you can experiment with

e  Overwrite all Databases — Overwrite older
Databases

. Upgrade all Configurations — Automatically
update all configurations to their most recent
version

. Use Unified Database — Install all
configuration in one unified database

ICONICS
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ICONICS Suite

. Enable Project Reporting — Enable and
setup Project Reporting on SQL server if
possible (Project Reporting is supported on
SQL 2008 R2 and higher)

The Database and Services Setup Dialog will
now appear. You can either leave the Include all
samples checkbox enabled (in order to install
sample data that you can experiment with) or
disable this checkbox to install blank tables.
Advanced configuration will allow settings for
additional sizing options on the database and log
files. You can enable Unified database (one
database that contains all the configurations) and
also you can enable Overwrite all (overwrite all
existing databases).

When the ICONICS GENESIS64 — InstallShield
Wizard window pops up , click on the Install
Button

ICONICS Suite - InstallShield Wizard X

» icouts
&

Click Install to beqin the installation.

If you want to review or change any of your installation settings, dick Back. Click Cancel to
exit the wizard.

< Back Install Canicel

The System Setup Dialog will now appear. You can
either leave the Include all samples checkbox enabled
(in order to install sample data that you can experiment
with) or disable this checkbox to install blank tables.

3-12
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Advanced configuration will allow settings for additional
sizing options on the database and log files. You can
enable Unified database (one database that contains all
the configurations) and also you can enable Overwrite all
(overwrite all existing databases), or you can use
Upgrade automatically all database configurations
(existing databases will be automatically upgraded to the
newest version).

A system Setup - o x
Install all configurations in one unified database | IcoUnifiedConfig =]

Database Prefix:

Include sampies in al configurations
] Ovenwrite al configurations

Automaticaly upgrade sl configurations

‘Setup Configuration

Setup Database: | leoSetup Inital Size: 2, Maximum Size: 100, Growth: 1, Log Size: 1 [ | (] Overwite
[ ——

Configuration Type | Samples | Overwrite| Upgrade
+ MarmWorX Multimedia u]

AlarmWorX64 Logger O

AlarmWork6a Server [u}

AertWork o O

Asets u}

8ACret o O

Biserver u}

9.  After completing the installation, the Wizard
Completed dialog box appears. Click the Finish
button.

ICONICS Suite - InstallShield Wizard

InstallS hield Wizard Complete

The InstallShield Wizard has successhully installed ICONICS Suite.
Bifore you can use the progiam, you must restart your computer

Thank you @i¥es, | wank to resta my computer now

for choosing
ICONICS Software

() No, | il resstart my compiiter later

. 2=
> ICONICS
-

< Back Cancel

ICONICS
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3.4 Uninstalling GENESIS64

The GENESIS64 software can be uninstalled (removed)
from the system. It is recommended that you back up all of
your project-related files before uninstalling. If your operating
system requires a login, you must log in with administrator
capability to uninstall. Uninstalling GENESIS64 Software (or
its components) will not uninstall the Licensing software.
Your valid license will remain activated on your PC.

It is recommended by ICONICS to use Add/Remove
Applications from Control Panel to uninstall the applications.
Since applications are registered in the Registry,
Add/Remove uninstalls the product and makes the required
Registry changes for you. If you uninstall some common
components that are used by the product, you may be
required to register those components again or simply
reinstall the product.

To uninstall GENESIS64: From the Windows Start menu,
select Settings > Control Panel. Double-click Programs
and Features. From the list of programs that you can
remove, select ICONICS GENESIS64. Click
Change/Remove or Uninstall to remove GENESIS64 and
all of its components. Select Remove, and then click the
Next button. When the files are removed, the uninstall
program will indicate that the process is complete.

If the Control Panel is not found under Settings, right click
on Start button and select Control Panel. In the Control
Panel window, under Programs choose ‘Uninstall a
program” option. Right-click on GENESIS64 and all of its
components and choose uninstall option

3-14 ICONICS
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[EH Control Panel

A [E > Control Panel

Adjust your computer's settings

History
Backup and Restore (Windows 7)
Find and fix problems

/ Hardware and Sound
' View devices and printers

Add a device

<. Programs

[51 Uninstall 2 program
Get programs

System and Security
Save backup copies of your files with File

=

i Network and Internet .
< View network status and tasks sl
Choose hamegroup and sharing optiens (7]

@

- a

Viewby: Category ™

User Accounts
& Change account type

ppearance and
Personalization
Change the theme

Clock, Language, and Region
Add & language

Change input methods

Change date, time, or number formats

Ease of Access
Let Windows suggest settings
Optimize visual display

When the files are removed, “Uninstall Complete”
message will pop up. Click on Finish button

Note: Do not delete the files and directories manually; doing
so will leave the Registry entries intact and interfere with
future installations. Please use the uninstall feature of the

operating system!
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4 ICONICS SOFTWARE LICENSING

4.1 Software and Hardware Keys

AnalytiX licensing is handled by a software key license
registration system that does not require a hardware
protection key. However, ICONICS does offer an optional
hardware key which you can purchase.

411 Software Licensing

The software key is a licensing key that resides on the hard
drive of a computer. Each software key is used on a single,
specific computer and is used only once. It is activated using
a Site Key (license file) that is tied to the computer that is
being licensed.

An activated license is required to use the software in full
production mode. This license designates which products
may be used, as well as the I/O point-count limit that controls
the number of active data points (tags) that can be used by a
system.

For important details about registering and activating
software licenses for your AnalytiX installations, refer to the
ICONICS .NET Licensing Readme.htm file, which is
available on your AnalytiX installation DVD (and as a link
from the disc’s Info Center).

41.2 Hardware Key

The optional hardware key is a USB thumb drive (or flash
drive) that you can move from system to system. AnalytiX
recognizes the hardware key on the system you have the
key attached to. A hardware key is easier and is a more
reliable way of moving a license from one machine to
another than a software key.

Upon insertion of the USB key into an available USB port,
the necessary drivers are automatically loaded.

A green status light will illuminate upon successful
connection. Should the USB key be missing or unplugged
during operation of AnalytiX software, plug the USB key
back in either within an hour of removal or upon system
reboot; otherwise the hardware-based license will not be
immediately recognized.

ICONICS 4-1
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Should you require a replacement key, visit
http://www.iconics.com/supportworx. New users must create
an account through the ICONICS Web Licensing Utility in
order to request replacement keys.

4.2 License Utility

The Software License Utility provides full authorization for
use to any purchased AnalytiX product and its available
options.

421 Running the License Utility
To launch the License Utility from the Windows Start menu,
select Programs > ICONICS .NET Licensing > License
Utility.
©  Software License Activation [ =2 -
File License Help
H‘Egﬁ&s Software Licensing
Information
Site Code: XU X000 XOOE XK XX XXX
Site Key: | No Curent Ste Key
Phumbers: [ No Cumert PNumbers
[ Copy PNumbers to Cipboard |
License File
|
Activate License
Activate Trial License |
Kill Currentt License
4.2.2 License File
Once you have opened the Software License Utility, you can
browse for the Site Key (License File) itself. Either click on
the Browse... button in the License File section of the
window OR click on File in the top menu, then Select
License File....
4-2 ICONICS
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; Software License Activation | = | = IR
m License
=

Select License File...

Exit

Information
Site Code: [ODOE 31F3 9DEF 4052 CC X1085 |

Ste Key:  [No Cument Ste Key |

PNumbers: | No Curent PMumbers

| Copy PMumbers to Clipboard |

License File

Activate License

Activate Trial License |

Kill Current License

This brings up the Windows Explorer so that you may
browse for the License File itself. Once you have located the
file, double-click it or click Open to proceed.

423 Activating the 30-day Trial/Emergency License

Within the License Utility (Software License Activation for
.NET) dialog box, you can click on the Activate Trial
License box to initiate a 30-day trial/emergency license.

NOTE: This license can be activated only once per
machine.
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]

File

Software License Activation | = | = NG |

License  Help

ri@}s Software Licensing

Information

Site Code: XXX XK XXOK MOOKK X XXXNK

Site Key: Mo Cument Ste Key

Phumbers: | No Cument PNumbers

| Copy PNumbers to Clipboard ‘
License File
Activate License
‘ Activate Trial License D

Kill Cumrert License

You will then see a warning about proceeding with activating
the 30-day trial/emergency license. Click Yes, should you

wish to proceed.

Doing so will ¢

Warning

The 30-day trial/emergency license can only be activated once per machine

hange your site code and will invalidate any software license

currently active on the machine.
Are you sure you want to continue?

<]

You will then see an additional warning confirming that you
understand that enabling the trial license will invalidate any
other software license that is currently active on the
machine. Click Yes should you wish to proceed.

ICONICS
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Warning \i‘

Enabling this trial license will invalidate any software license currently active on
the machine, Are you sure you want to continue?

Once the 30-day trial/emergency license has been enabled,
you will see the following messages:

Success -

License Activated Successfully

Success -

Emergency/Trial License Activated

The PC will then be authorized to run for a one-time only,
30-day backup period. The PC can be fully authorized at any
time during or at the conclusion of this temporary backup
period. Clicking No in the initial windows returns you to the
License Utility (Software License Activation for .NET) dialog
box and preserves the existing license.

Note: Temporary backup license authorization is intended
for urgent backup situations only. Clicking OK invalidates the
existing license and activates a temporary backup
authorization, permanently overwriting any existing license.

ICONICS 4-5



GenDemo GENESIS64 Getting Started

4.2.4

Thus, please use caution when activating a temporary
backup license authorization.

Killing a Software Key License

Killing a software key license deletes it and removes the
current software license from the machine.

To Kill or Delete the Existing Software License:
1. Select Kill Current License within the License Utility
(Software License Activation for .NET) dialog box. Using

this option, you can remove the current software license
from the current machine.

| Software License Activation | =[5 -

File License Help

H@}s Software Licensing

Irfarmation
Site Cods: 000X X000¢ YO0 300 XX XXX
Ste Key: [N Curent Ste Key

PNumbers: | No Cumert PNumbers

‘ Copy PNumbers to Clipboard ‘

License File
[ |

Activate License

Activate Trial License
E Kill Cumentt License b

A warning message appears on the screen as shown in the
figure below.

4-6
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Warning ILI

Are you sure you want to kill the current license?
This action is permanent

Yes | | Mo

IMPORTANT: If you kill your license, you need to get a new
license from ICONICS to restart your AnalytiX product.

2. Click Yes to continue, or click No to exit. Clicking Yes
displays one of the following warning messages.

If you are killing a trial or emergency license, once you
click Yes you are done.

Note: A trial or emergency license cannot be credited
back to the web-based License Generator using the Kill
Code.

If you are killing a permanent, registered license, after
you click Yes, the following warning message appears.
Notice that the message lists the old Site Key, and a Kill
Code. It also lists a .TXT file that has been written to
the PC's desktop; the file name begins with "KillCode".
This file contains the old Site Key and Kill Code that are
listed in the message.
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License Killed

License killed successfully.
License information displayed below and written to:
C:\Users\admin\Desktop|

Please keep a copy of the information for your records.

Old Site Key:
59C3 6ED9 BOBS 7E10 AABD D360 2E Copy

Kill Code:
5227 CCD1 8601 7D65 95C3 044A 3D5A FB Copy

oK

3. Click Yes to copy the Kill Code to the Windows
Clipboard so that you can paste it elsewhere,
such as in an email to ICONICS Support or on
the ICONICS Web Licensing Utility. If you don't
need to copy the Kill Code at this time, click No.

4. Look on the desktop for the KillCode*.TXT file.
Keep this file, and copy it to a safe location!
You will have to use the information it contains to
confirm that you have killed your license (via
either the ICONICS Order Entry Department or
the ICONICS Web Licensing Utility).

5. Proceed with the online steps described in
4.4.3.1 “Killing a License via the ICONICS Web
Licensing Utility”

Note: To reinstate a permanent license that you killed,
you will need to provide the KillCode*.TXT file to
ICONICS.

4-8
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Note: If you uninstall the Software License Utility, the
KillCode*.TXT file will be deleted. For this reason,
make sure you copy the KillCode*.TXT file to a safe
location or be sure to note or print its content before
uninstalling the Software License Utility on the PC. [*
= Site Key that was killed.]

4.3 License Viewer

When you purchase licenses, the licenses are measured in a
point count that determines the number of OPC tags that you
can use in your application. One point count is used for most
AnalytiX applications. There are two different modes for
using tags in point counts:

. On-demand mode. A system for dynamically using licensed
points, and then reusing the points as needed. The count
at any instance includes only active points in use.

e  Configure mode. A system in which all points are
statically configured in a static central location, inside
the Unified Data Manager. All configured points are
counted against the point count.

The two mode types are not interchangeable and require
you to buy a new license to upgrade your existing license
status.

At any time, you can use the License Viewer to review the
license status of ICONICS products installed on that
computer. You can access the License Viewer by:

. From the Windows desktop: click Start > All Programs
> ICONICS Licensing > ICONICS .NET Licensing >
MonitorWorX Viewer.

. From the Workbench: from the Tools ribbon click the
Licensing button. Or from the File menu, select Tools,
and then Licensing. The License Viewer displays as
shown in the following image.

ICONICS
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Ll MonitoriorX Viewer - oM

@

The tab that displays initially is the Overview tab, where you
can see general information about the license for the server
that the node points to. You can view license information for
GENESIS64, AnalytiX, Data Connectors, BizViz products
(under the AnalytiX tab), and AlarmWorX Multimedia
product features by using the tabs for those products. To
locate the nodes where individual product features are
consuming the server's license counts, use the Diagnostics
tab.

4.4 Web Licensing

You can use the ICONICS Web Licensing Utility to generate
a new license, kill a license and transfer a license. One
function of the ICONICS Web Licensing Utility is to use it to
upgrade your license.

Supported operating systems for using the ICONICS Web
Licensing Utility to upgrade your license include Windows 8
x64 (Professional or Enterprise Edition), Windows 7 x64
(Professional, Ultimate, or Enterprise Edition), Windows
Server 2008 R2 x64, Windows Vista x64 SP2 (Business,
Ultimate, or Enterprise Edition), Windows Server 2008 x64
or Windows Server 2003 x64. Using the utility will require
Internet access and a web browser (e.g. Internet Explorer
6.0 and up).

4-10
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4.41 Acquiring a New Software License

Users of ICONICS software can use the ICONICS Web
Licensing Utility to acquire a new software key license.

4411 Issuing a New Software License

1. On the machine where you want the AnalytiX
license to reside, open the License Utility by going
to Start -> Programs -> ICONICS Licensing ->
ICONICS .NET Licensing -> License Utility. This
should open the Software License Activation for
.NET window.

2. You will see a dialog come up with a Site Code
and “No Current Site Key” within the Site Key text
box. Leave this window open.

. Software License Activation | = | = [0

File License Help

»ic{y}s Software Licensing

Irformation
Site Code:  XX0C XOOK XK MO XX XXXXX

Ste Key: [No Curent Ste Key

PNumbers: | No Curent PNumbers

[ Copy PHumbers to Clipboard

License File

|

Activate License

Activate Tral Licenss |

Kill Cumrert License
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Go to http://www.iconics.com/supportworx and
launch the Web Licensing Ultility Site by clicking on
the “License Now” link on the bottom left of the

page.

Or, from ICONICS website
(http://www.iconics.com), select “License a
Product” from the bottom-right Customer
Connection area.

The main page of the Web Licensing Utility will
load. Click on the “Software” button to access the
Software License Options.

ICONICS Web Licensing Utility

[ Srrome— ———r——]
Microsoft Partner
bt il /

\\‘~"
"8‘- GENESI564
Hyper Hlsl_

4-12
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5.

You will be required to log in to access the
Software License Options. Enter your email
address and password and click on the “LOGIN”
button. If you do not yet have an account, you can
create one by clicking on the “Create New
Account” link near the bottom of the page.

—

Once you have logged into the website, click on
the “New License” link in the top navigation bar.

Enter your Product Registration Numbers and
Customer Keys for the products to license, then
click “Next”.

NOTE: Your Product Registration Number and
Customer Key are usually inside the DVD package
that ICONICS sent to you.

ew License

o L MR

ICONICS
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8. In the next screen, you will be requested to identify
the end user for whom the license is being issued.
You can look up a list of users that have been
previously entered by clicking on the “Existing End
Users” link or can enter a new one by clicking on
the “Create New” link.

End Usor informaticn
Please identity an End Liser by chohing cne of e opions below

Exignng End Ugors Lreaty Hew

9. Clicking the Existing End Users link will open a
new window with a list of previously entered end
users (either entered by you or tied to the product
registration numbers entered in the previous
screen). Select an end user from the list and click
“Select” or double-click the selected end user.

If you, yourself, are the end user and you are not
listed in the grid, you can click on the “l am the
End User” link to enter your data as the new end
user. After identifying the end user, click on “Next”.

[Select an end user from Ehe kst below

End User Look Lip -~ Webpage Dalog ===
END USER LOOK UP

gy Coaniey inaie
ICOMICE, inc.
ICOMICS, Ine.
ICOMICS, D
JeTy.ne

BEEE
EEEE

[TEeeet [TCanceT ]

Creake Hew Lam the Eod User
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10. In the next screen, you will see a list of the
products that are available for you to license.
Check all the products that you would like to
license. Copy the Site Code from the license utility
of the destination machine and paste it into the
Site Code box of the current web page, then click
on “Next”.

New License
Below are the produer(s] that yuw hava purchated and that have nat vet Deen Fssignad 3 SKE key,
o regitar product(s) 1o a soenfic system, da the follawing

at to the prodect namels) that you would ke to assign
22 Cade text ba

Enablé the dheck b
- Enterthe si

er 52 i
tha ICONICS License Utity. Salect the Autherize Litense command fram the Adions

can be found in

WS (0R va
LEDEL 10R Ve

KINENT LEERSE FOR Y

Entor Slte Coda of the PC : S35E 2ACH BAES C104 0123 440 FOES FE

11. Review the license information before proceeding.
Click on “Generate Key” to issue the new Site Key.

Home » Software Lisense » New License
New License
You requested to have the products below be registered to the following Site Code

54B3 AE27 40AD ADE7 D5

[ —— | o 1

[ ceterviostestias viosuicense P 113111111583 orDEseOsARIADSSFHS

Total Bizviz/GEN32 Paint Counts :0
Total GENG4 Paint: Count: 100000

‘Total Hyper Historian Point Count: 100000
License Days
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12. The next page will show you a summary of what

will be your license, as well as your Site Key and

License File.

Home » Software Livenze » New License

The following License File has been assigned to your system for use in license activation.
Use the License File inside the ICONICS Software Licensing Utility.
Please keep the Site Key for future reference purposes.

site Gode: 54B3 AE27 40AD ADE7 D5
Site Key: 1B44 954F E61A 79ED 5FFA 6610 7C

Download the following LICENSE FILE to authorize your license
Click here to download

Registered Products

[~

]

order #

P

lProduct Description|

|GENGI-VIDS TEST LAB. VI0SLICENSE  12Fehvusryao10 25546H0 PNBSST113111111643 ONOEB80SAB3ABSGF A5 CUo2oss |

We recommend that you print this screen far your recards. Use the print friendly button an the left

An email has been sent to your email account with the above information,

Thank you for choosing ICONICS

13.

14.

15.

16.

17.

Download the license file (*.glic) by clicking on the
link. You will need this file to license the machine.
NOTE: If you misplace the file after receiving i,
you can use the View License link with your
Product Registration Number to download it again.
In the Software License Activation Utility, click on
the “Browse” button and look for the license file
that you downloaded from ICONICS website.
Once you have selected the file and the License
File textbox shows the file path, click on the
“Activate License” button.

You should then receive a popup message
indicating the status of the license activation. You
can click on “OK” to close the dialog.

The Software License Activation Utility should now
show the current license information, similar to the
following image.

ICONICS
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GenDemo

. Software License Activation | =[5 -

File License Help

> i@}s Software Licensing

Information
Site Code: KXXX KK OO0 KK XK

Sie Key: [ No Cument Sie Key

PNumbers: | No Cument PNumbers

‘ Copy PMumbers to Clipboard |

License File

Browse...

Activate License

Activate Trial License |

Kill Cumrent License

18. Notice that the Site Code may change, as

expected, but the Site Key should be the same

one you saw on the website.

ICONICS
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4.4.2 Adding to an Existing Software License

1. Go to http://www.iconics.com/supportworx and
launch the Web Licensing Utility Site by clicking on
the “License Now” link on the bottom left side of
the page.

2. Once you have logged into the website and
accessed the Software License main page, click on
the “Add to License” link in the top navigation bar.

3. Enter your Existing Site Key, Product Registration
Numbers and Customer Keys, then click “Next”.

Add To License

4. In the next screen, you will see a summary of the
current license and a list of products that are
available for you to add to the existing license.
Check all the products that you would like to
license. Copy the Site Code from the License
Utility of the destination machine and paste it into
the Site Code text box of the current web page,
then click “Next”.
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5. Review the license information before proceeding.
Select “Generate Key” as shown in the following
image.

Product ey

Products) o Add

SBA7 ASAT FSF2 D208 0439 AG40 CADD 6F

| -

6. The next screen will display the new Site Key and
the link to your license file. Follow steps 13 to 18
from 4.4.1.1 “Issuing a New Software License” to
complete the licensing process.

4.4.3 Upgrading a Software License Key

There are four basic steps when it comes to upgrading a
license via the Web Licensing Utility:

o Step 1: Kill the older version license and credit it on
our website

e Step 2: Upgrade the license on our website

¢ Step 3: Uninstall the older version of software and
install the newer version

e Step 4: License the newer version

The order in which you do Step 2 and Step 3 does not
matter.
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4.4.3.1 Killing a License via the ICONICS Web Licensing Utility

See Section 4.2.4 “Killing a Software Key License” for the
initial steps on how to kill a license within the License Utility
(Software License Activation for .NET) provided on the
AnalytiX DVD. Be sure to take note of the Site Key and Kill
Confirmation Code. This information is necessary to put the
license back on the ICONICS website. NOTE: This
information is also in the KillCode*.TXT file.

[* = Site Key that was killed.]

Once you have the Kill Code, follow these additional steps:
1.  Go to http://www.iconics.com/supportworx and

launch the Web Licensing Ultility Site by clicking on
the “License Now” link on the bottom left of the

page.
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2. The main page of the Web Licensing Utility will
load. Click on the “Software” button to access the
Software License Options.

ICONICS Web Licensing Utility
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3. You will be required to log in to access the
Software License Options. Enter your email
address and password and click on the “LOGIN”
button. If you do not yet have an account, you can
create one by clicking on the “Create New
Account” link near the bottom of the page.

=
]

NICS Web Licensing Utility

o Linaing Uiyt
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4. Click on the “Kill License” link in the top navigation
bar.

5. Copy the Site Key from the KillCode*.TXT file into
the Site Key field on the web page, then copy the
Kill Confirmation Code into the Kill Code field on
the web page. Next, click on the “Remove Key”
button on the web page.

Hame = Satbwers Lcerse « il Lerse

Kill License

Slesse enter the £7 ey ko b2 raded and ated il Canfimation Cade.

Please enter Site Key ad Kl Coe exatly a5 5
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Kill Code: TACE AEDE EA|
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6. You will get a message confirming that the Site
Key has been successfully deleted as shown in
the image below. The products associated with the
deleted Site Key will now be available to be re-
licensed.

Home » Software Lisense » KilLicense

Kill License

Site Key suceessfully deleted
site Key: 1B44 954F E61A 79ED SFFA 6610 7
Kill Code: 6D57 GEFB FBFE 05B6 BD53 7A08 4ED5 EA

The following products are again available to you for registration:

Available Products
T Promsikey[produt Dossrpton]_oraortste_Jorder#]__pregie | chegto[Customeriia]
|cemeevosTesTLABL vio sucense sesiaro cusozze_|

n the laft,

Thank you for choosing ICONICS,
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4.4.3.2 Upgrading the License on ICONICS Website

See Section 4.2.4 “Killing a Software Key License” for the
initial steps on how to kill a license within the License
Utility (Software License Activation for .NET) provided on
the AnalytiX DVD. Be sure to take note of the Site Key
and Kill Confirmation Code. This information is necessary
to put the license back on the ICONICS website. NOTE:
This information is also in the KillCode*.TXT file.

[* = Site Key that was killed.]

1.  After you have copied your Site Key and Kill
Confirmation Code in the previous step (either
physically or electronically), you can now visit
http://www.iconics.com/supportworx.

2. Next, click on the “License Now” link. This opens a
new Web page, as shown below.

T
ATt
B\ e

& BB GENESIS64
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3.  Click on the “Software” button to proceed. You will
then be required to enter your email address and
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password for the site, as shown below. If you do
not already have a login for this page, click on the
“Create New Account” link near the bottom of the
page.

810063 e g - e e oo el

ICDNICS Web Licensing Utility

o the new TCONICS Web Liensing Utibty!

4. Once you have logged in, click on the “Kill
License” link in the top navigation bar.

5. Next, fill in your Site Key and Kill Code information
that you copied while killing your previous license
(see 4.2.4 “Killing a Software Key License”).

Kill License
Please enter the Site Key to be credited and the associated Kill Confirmation Code.

Please enter Site Key and Kill Code exactly as shown in KILL.TXT file, including spaces.

ite Key: [250C 3CDD 0524 5252 2083 456F D438 85C5 B799 0B
Kill Code:[CB1E B52F 8984 0867 F679 6767 69A3 DDEF 01C0 2480 28EF 99

To remove a license for GENESIS32, do the following:

1. Click on start, programs, ICONICS Software License, and select License Utiy.

2. Select the Kill License command from the Actions me

5. Enter your name, date and the password "solc lower case) into the dilog box; then dick the OK butt
The License Uty generates 3 dislog box containing your Site Key and the sssocated Kl Coe and stores this
Information to the KILLITXT le i S.5yStembriveSe\Program FlesCONICS\StLic.

4. Enter your Site Key and Kill Code into the text boxes above; then diick the Remove Key button.

To remove a license for GENESIS64, do the following:

1 Click on start, Programs, ICONICS GENESISs, Licensing Utiy.
2. Click the Kill License butfon on the main panel and cick
3

The Licanse Uity generates a dalog box contaiing your Site Key and the assocated Kil Code and stores this
information to the KilCode.txt file on your current desktop.

. Enter your Site Key and Kill Code into the text boxes above; then dlick the Remove Key button.

6. Once you kill the license on ICONICS’ website,

you will receive an email containing the following
information:
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. Site Key
e Kill Code
. Product for which you have killed the license

The web page itself should now look similar to the
figure below.

Home > Software Lisense > Kil License

Kill License

Site Key successfully deleted
Site Key: 250C 3CDD 0524 B282 2DB3 456F D438 85C5 B799 0B
Kill Code: CB1E B52F 8984 0B87 F679 6767 89A3 DDEF 01C0 24B0 28EF 99

If products in this license are eligible, they may be upgraded to the latest version here.
The following products are again available to you for registration

Available Products

oo e e——— e e e W
‘ GEN32VE- | V8 GEN32 RUNTIME 5000 PT- 1 Z=Tm — o ‘
U —

Thank you for choosing ICONICS.

7. Atthis point, you have completed killing the
license. Notice that in the final “Kill License” page,
as shown above, it states that if the license is
eligible, it can be upgraded to the latest version
and it provides a link for availability.
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Checking License Upgrade Availability

The easiest way to check if your license is available for an
upgrade is by clicking the link on the page immediately after
you kill the license. Clicking the link brings you to the

Upgrade License page. You can also get to this page by

clicking on the “Upgrade License” link in the tree control

(third item).
Follow these steps to upgrade your license.

1. On the Upgrade License page, fill in your Product

Registration Number and Customer Key. This is
the same information you received in the web
page and in your email after you have killed the
license on our website.

2. Click on “Next” when you have filled in the

necessary information.

3. If the license is available for an upgrade, you will

see the available license on the page.

Below are the product(s) that you have purchased that are available for upgrade.

To upgrade product(s), do the following

Upgrade License

Enable the check box(es) next to the product name(s) that you would ke to upgrade.
3 Chathe Next button to santm

Available Licenses

= T T T e

L= GeN2ve-5000 VB GENS2 RUNTIE 5000 PT- 1 USER | PI2111111111111111 | GNDT23456769123456 Avadable |

P e

4. Notice that the Product Description here shows a

different product with an earlier version license
(Version 8). Yours should reflect the license you
have for your product. Check the available product
that you would like to upgrade and click on “Next”.

5. The next page is a confirmation page. Check that

the information shown is correct and click on the
“Upgrade” button to proceed.
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6. On the new page that loads next, you can see a
list of upgraded products. Notice that the Product
Description shows a license for a later version
product (Version 9.2) instead of the earlier one
(Version 8).

Home > General Information » Upgrade License

The following products have been successfully upgraded:

Upgraded Products
| e re—— e e r—

H Customer H
Key

‘ sz»fnzn\n@z, 5000 PT- 29549HQ. 5 56| CUS02266

1USER

We recommend that you print this screen for your records. Use the print friendly button on the left
An email has been sent to your email account with the above information.

Thank you for choosing ICONICS.

7. You should also receive an email with the license
upgrade information.

Upgrading a Hardware Key License

Upgrading a hardware key license is similar to upgrading the
software key license. You would follow the exact same
procedure as upgrading a software license. In the case of a
Hardware key License though, you will need the USB dongle
in order to kill the license from it and put the new one onto
the key.

Licensing the New Version

Now that you have upgraded the license, you can follow the
regular procedure to license your machine with the new
version. When it asks you for the Product Registration
Number and the Customer Key, you can provide the same
one. This information was sent to you in the last step of
upgrading your license via email. If you need more
information on how to license the machine with the upgraded
license, please consult our application notes titled Licensing
— Using the ICONICS Web License Ultility for Software Key
Licenses and Licensing — Using the ICONICS Web License
Utility for Hardware Key Licenses, as it pertains to your
individual situation. These Application Notes and more can
be found via the Info Center on the AnalytiX DVD.

ICONICS
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4.5 Cloud Licensing

4.5.1

4.5.2

How Cloud Licensing Works

ICONICS Cloud Licensing is a means of licensing ICONICS
products that is specifically designed for applications running
on public cloud, private cloud, or virtualized environments.
Rather than maintaining the license locally on the machine,
licenses are hosted by ICONICS on a publicly-accessible
data center.

During normal operations of the licensed machine, the first
action it takes when starting up is to request the license
information according to its License Pool ID. This request
requires the machine to have access to the internet in order
to request the information from the ICONICS cloud licensing
server.

Once the license information has been successfully
retrieved, the machine continues to operate using the
licensing information retrieved from the web. The machine
then periodically checks with the ICONICS Cloud Licensing
server in order to validate the license. If it cannot validate the
license for an extended period of time, the machine license
will fail.

Issuing a New Cloud License

Follow these instructions to activate a license on a machine
that currently has no license on it, or has a license on it that
you want to overwrite.

If your machine already has a license on it and you are
looking to add another license to it, see the next section
entitled, “Adding to an Existing Cloud License”.

1.  Go to http://www.iconics.com/support and click the
“License Now” link.
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2. Inthe new page that appears, select “Cloud” and log in
with your username and password.

o
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S W GENESIS6s
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Note: If you do not have a username and password pair, you
can register for one using the “Create New Account” link at
the bottom of the window. If you have a username and
password but have forgotten them, you can click on the
“Forgot Password” link at the bottom of the window.

3. Once you have logged into the website, click on the
“New License” link at the top.

4.  Enter your Product Registration Number(s) and
Customer Key(s) for the products.

Note: Your Product Registration Number(s) and Customer
Key(s) are usually inside the DVD tin package that ICONICS
sent when the product was purchased.

5.  Click the “Next” button once you have entered all of
your Product Registration Number(s).
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6. Choose an existing end user or enter new end user
information. Click “Next” when done.

Note: The existing end user dialog may take a few moments
to appear. Please be patient.

7. On the next screen, you see a list of the products that
are available for you to license. Check all the products
that you would like to license on this machine. Click
“Next”.

8. This page shows you a summary of what is in your
license. Check to make sure everything is correct, then
click on the “Generate Key” button. A page similar to
the image below appears.

New License

The follor

License Pool: AGAFSEF]-D269-4356-A34D-637CDAB3ADD

Registered Products

e TPt T
| — mm\ P IO R [l PO |
MON |

4/ 55351HQ |PH1264CIZ0BEAECF A1 cusmzss oS o5

Thank vou for choosing ICONICS.

Activating the License

1.  Open the “Platform Services Configuration” application
by going to Start > Programs > ICONICS > Tools >
Platform Services Configuration.

2. Select the “License” tab.

3. Select the radio button for “Cloud License” and enter
the “License Pool” code that was provided by the Web
License Utility. You can leave the “Password” blank.

4. Restart the FrameWorX64 Service.
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Adding to an Existing Cloud License

1.  Go to http://www.iconics.com/support and click the
“License Now” link.

2. Inthe new page that appears, select Cloud and log in
with your user name and password.

3. Once you have logged into the website, click on the
“Add to License” link at the top.

Note: It is very important to pick “Add to License” and not
“New License”. Picking “New License” overwrites any
existing license already activated on this machine. Make
sure to pick “Add to License” if you are adding products to a
machine that already has a license on it.

4. Enter your existing License Pool ID and the Product
Registration Number(s), and Customer Key(s) for the
new products.

Note: Your Product Registration Number(s) and Customer
Key(s) are usually inside the DVD tin package that ICONICS
sent when the product was purchased.

5.  Click the “Next” button once you have entered all of
your Product Registration Number(s).

6. Choose an existing end user or enter new end user
information.
Click “Next” when done.

Note: The existing end user dialog may take a few moments
to appear. Please be patient.

7. Inthe next screen, you see a list of the products that
are available for you to license. Check all the products
that you would like to license on this machine.

Click “Next”.

8. This page shows you a summary of what is in your
license. Check to make sure everything is correct, then
click on the “Generate Key” button.

ICONICS
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4.5.5 Killing a Cloud License

1.

Go to http://www.iconics.com/support and click the
“License Now” link on the bottom left of the page.
Select the “License” tab.

In the new page that comes up, select “Cloud” and log
in with your username and password.

Once you have logged into the website, click on the “Kill
License” link at the top. A page similar to the figure
below appears.

Kill License

Please enter the License Pool to be removed and credited.

License Pool:

To remove 3 Cloud License for GEMESISSS, do the following

1. click on Start, Frograms, ICONICS, Tools, Flatform services Configuration
2. Click the License tab and copy the License Pool
3. Enter your License Fool into the text box above; then click the Remove Pool button.

Enter your License Pool ID into the prompt.

Click “Remove Pool”.

A message confirming that the license has been
successfully removed appears. You will also receive an
email with the killed license information. The products
associated with this License Pool are now safely parked
on the website and available to be re-licensed at any
time.
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4.6 Demo Mode

Without a valid license installed in your PC, it is still possible
to use AnalytiX in Runtime mode. The software will check for
a valid hardware or software license key on initialization. If
none is found, GENESIS64 runs in Demo Mode, which limits
you to:

e  Twelve hours of runtime
e  Only 64 OPC tag connections (points) can be updated

Running AnalytiX longer than the 12-hour limit generates a
message stating that the demo time has been exceeded.
You must then exit AnalytiX and reboot the PC. On restarting
AnalytiX, you will get another 12-hour block of time in which
to run. If there are more than 64 tags on a particular screen,
gray keys (or whatever is configured as the Point Failure
character) will appear in place of the actual I/0 data.

ICONICS
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5 GENDEmMoO

5.1 Introduction

You can get a sense of the rich applications that can be
created by using ICONICS' GenDemo. GenDemo is a set of
GraphWorX64 display files installed with your system to help
you explore and learn about the features of GENESIS64,
AnalytiX, MobileHMI, and Hyper Historian, as well as to find
out how ICONICS applications are adaptable to different
industries.

This chapter provides a brief overview of GenDemo. You are
strongly encouraged to explore all the available files.

ICONICS Overview
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To launch GenDemo, from the Windows Start menu, select
Programs > ICONICS Tools > GenDemo. This opens the
GenDemo home page, shown above. This can also be
reached by navigating to http://gendemo.iconics.com.
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5.2 GenDemo Options

There are several configurable options that are located along
the bottom of the GenDemo screen, which may be useful
when navigating. They are:

Run in Carousel Mode - This button opens the Carousel
display and enables the Carousel mode, which automatically
advances through a set of displays according to the selected
playlist. The Carousel display also allows you to open the
Carousel control panel for more granular control over
playlists.

Select Color Scheme - This button allows you to select
from a variety of different color themes for your GenDemo
application.

Select Language - This button allows you to change the
language of your GenDemo application. Don’t see your
desired language? Contact us to put in a request at

info@iconics.com.
5.3 Industry Case Studies and Examples

As stated earlier, GenDemo contains a large number of
example projects, many of which have been used by real
customers. You may find specific examples related to a
particular topic in the respective topic’s menu, or you may
open the complete list of demos separately. The list of
demos can be found from the menu under the Industries >
Customer Examples section. This will open up a display
containing all of the GENESIS64 examples that come with
GenDemo. You are encouraged to look through these and
see how the graphics have been developed. If you would like
to learn more about how any of the examples function, you
are encouraged to open the files themselves, in
configuration mode, from the GenDemo > Examples
directory where you installed GENESIS64.
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6 GENESIS64 QuICK START

6.1 Introduction

This chapter provides a brief overview of the following
GENESIS64 products and tools:

GraphWorX64

AlarmWorX64

TrendWorX64

EarthWorX

GridWorX

Workbench

Additional tools and utilities

Note: For complete information about any GENESIS64

product, please refer to the GENESIS64 Help, which you
can launch from any GENESIS64 product.

6.2 GraphWorX64

GraphWorX64 is the GENESIS64 product you use to create
graphical human-machine interfaces (HMIs). GraphWorX64
has dozens of tools with hundreds of parameters and
combinations to create powerful, dynamic, and interactive
images in two or three dimensions. Use the interactive
tutorials in the GenDemo Learning Center (see the
description in Section 4.1) to explore the tools that are
available to you in GraphWorX64.

To launch GraphWorX64 from the Windows Start menu,
select Programs > ICONICS > GENESIS64 >
GraphWorX64 > GraphWorX6é4.

GraphWorX64 has a number of examples available to you.
To use them, while in GraphWorX64, select Open from the
File menu and browse to the following directory: \Program
Files\ICONICS\GENESIS64\GenDemo\. In this folder you
will find subfolders with a name prefix of GWX_. Explore the
folders and open example files to see what they offer.

ICONICS
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6.3 AlarmWorX64

AlarmWorX64 is the alarm monitoring, logging, and reporting
module in GENESIS64. AlarmWorX64 consists of:

e AlarmWorX64 Viewer — Which you use to configure
real-time alarms and attach them to alarm sources;
display alarm notifications; make it easier to notice,
respond, and acknowledge alarm conditions; and view
historical alarms.

. AlarmWorX64 Server — Receives data from OPC-
compliant Data Access servers and performs alarm
detection and reporting.

e AlarmWorX64 Logger — Stores alarm data to a SQL
database, which you can use for later replay.

To launch AlarmWorX64 from the Windows Start menu,
select Programs > ICONICS GENESIS64 > AlarmWorX64
> AlarmWorX64. AlarmWorX64 opens inside the
Workbench.

A presentation in GenDemo (see the description in Section
4.1) provides an overview of AlarmWorX64. For a complete
understanding of AlarmWorX64, access GENESIS64 online
Help while in AlarmWorX64.

6.4 TrendWorX64

Use TrendWorX64 to plot real-time and historical OPC data
into charts and graphs of all kinds, which you can then use
as multifunctional HMI graphic displays. TrendWorX64 has a
number of tools you can use to satisfy a wide range of
applications.

To launch TrendWorX64 from the Windows Start menu,
select Programs > ICONICS GENESIS64 > TrendWorX64
> TrendWorX64. TrendWorX64 opens inside the
Workbench.

A presentation in GenDemo (see the description in Section
4.1) provides an overview of TrendWorX64. For a complete
understanding of TrendWorX64, access GENESIS64 online
Help while in TrendWorX64.

6-2
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6.5 EarthWorX

Use EarthWorX to incorporate drill-down technology to
quickly view alarm conditions for any location around the
world, using maps available with Microsoft Bing. EarthWorX
helps you to visualize geographically-dispersed assets (such
as factories, facilities, or job sites) and track movable objects
using GPS coordinates.

A presentation in GenDemo (see the description in Section
4.1) provides an overview of EarthWorX. Instructions for
using EarthWorX are available in GENESIS64 online Help.

6.6 GridWorX

GridWorX allows users to visualize, edit and update
database tables through GENESIS64. Built in two parts the
GridWorX Server can be found within Workbench, while the
GridWorX Viewer can be added to GraphWorX64 HMI
screens through the Controls tab of the GraphWorX64
Ribbon.

6.7 Workbench

The Workbench is the centralized Web-based interface in
which you open GENESIS64 products and configure
GENESIS64 components, runtime, and security. Every
GENESIS64 component can be loaded, worked with, and
run inside the Workbench. Projects can be packaged and
deployed from inside the Workbench, too.

When you select the Workbench command from the
Windows Start menu the Workbench loads with all of the
applications showing in the Project Explorer. It swaps in
functions with each GENESIS64 product that you load in it.

GENESIS64 providers can be opened from within the
Project Explorer in the Workbench.

To launch the Workbench from the Windows Start menu,
select Programs > ICONICS > Workbench. A presentation
in GenDemo (see the description in Section 4.1) provides
an overview of the Workbench. For a complete
understanding of the Workbench, access GENESIS64 online
Help while in the Workbench.
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6.8 Additional Tools and Utilities

In addition to the many products and tools already described
in this guide, there are additional tools and utilities are
installed with GENESIS64. A brief description of each is
described below. For more information about a tool or
feature, refer to GENESIS64 online Help, which you can
access from any GENESIS64 product or tool.

Use License Viewer (ICONICS Licensing > ICONICS
.NET > Licensing > License Viewer) to review the
status of your ICONICS licenses. See page 4-1 for
additional information.

Use GenBroker64 to set up network communications
to legacy OPC servers residing on other machines in
the same network or the internet. (You don’t need
GenBroker if you are talking to OPC UA servers.) You
configure GenBroker properties from the FrameWorX
Configurator, which you can launch by clicking Start >
Programs > ICONICS > Workbench and choose the
FrameWorX Server Provider. Once the FrameWorX
Configurator is open, expand the tree for the host and,
below the “Classic OPC” item, double-click GenBroker.

Use Global Aliasing to set up aliases for use across
GENESIS64 products. Click Start > Programs >
ICONICS > Tools > Global Aliasing.

Use Security to restrict operator and workstation
runtime access. Privileges can be granted by a number
of means, including application action, points, alarms,
files, stations, and custom strings. To work with
security, click Start > Programs > ICONICS >

Tools > Security.

TraceWorX provides online diagnostics and tuning of
applications running in GENESIS64. TraceWorX is
intended for use by systems integrators, OEMs and
customers who want to have tools for doing their own
troubleshooting and diagnostics. To work with
TraceWorX, click Start > Programs > ICONICS >
Tools > TraceWorX.
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Save implementation and development time by using
the Unified Data Manager (UDM) to create libraries of
reusable expressions, value sets, tag groups, alarm
subscriptions, alarm filters, recipes, and event triggers
across ICONICS products. To work with the UDM, click
Start > Programs > ICONICS > Tools >

Unified Data Manager.

Use the SNMP Connector to create, monitor, and
manage your own Network Management Systems
through GENESIS64, giving Network Managers access
to information from nearly every device connected to
the network, all from one application. To work with the
SNMP Connector, click its button or icon in the Project
Explorer in the Workbench.

Use the ICONICS BACnet Connector to integrate
BACnet communications into the GENESIS64 and
GENESIS32/Workbench32 product families. To work
with the BACnet Connector, click its button or icon in
the Project Explorer in the Workbench.

ICONICS
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7 HELPAND TECHNICAL SUPPORT

7.1 Help Documentation

ICONICS software provides online help with descriptions
and explanations of each application. Help is available
throughout ICONICS Suite. You can access help in the
following ways:

. Click the Help @ icon in the Workbench. This opens
the help file for that application. To search for a topic in
the help file, click the Index tab or the Search tab. Type
or select the term you want to find, and then click the
topic you want to read.

. Press the F1 key to display context-sensitive help.

. Click the Help button in any dialog box to display
context-sensitive help for that dialog box.

¢  Move the mouse pointer over an icon and pause for a
moment to display pop-up ToolTips for quick help.

. From the Windows Start menu, select All Programs >
ICONICS Help > Help

7.2 Product Videos

A new feature of the Customer Connection Portal is the in-
depth training videos highlighting many ICONICS products.
These videos help users configure their systems using best
practices. Starting with a Quick Start series introducing each
module in GENESIS64, these videos provide brief overviews
and demonstrations of how to use ICONICS products. Send
us your suggestion for topics to cover!

7.3 Training Classes

Training classes are held regularly at the ICONICS training
facility in Foxborough, Massachusetts. To reserve seats in
training courses and to view the current ICONICS training
schedule, go to http://www.iconics.com/Training.aspx. If you
have any questions about ICONICS training, please contact
our training coordinator at 508-543-8600.
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7.4 Technical Support

7.4.1

7.4.2

ICONICS customers may obtain technical support in several
different ways. First-line Support is through your local
ICONICS representative or distributor. You may also contact
ICONICS’ Support Engineers directly by phone, email or the
Customer Connection Portal
(https://getconnected.iconics.com).

For complete information about Global Technical Support,
please see the Global Support and Services User Guide at
http://www.iconics.com/supportworx.

Global Support and Services

ICONICS is proud to provide our customers with the highest
quality customer service. Our Global Support and Services
programs are supported by ICONICS offices around the
globe and our network of sales channel distributors and
representatives, with local and regional locations for front-
line service and expert assistance. Programs include the
SupportWorX™ Technical Support Services subscription
program for continuous technical support; Quality
Professional Services for expert system architecture
design assistance, training and start-up assistance; a 24 x 7
Emergency Support Option plan; and Training and
Certification programs for ICONICS users, systems
integrators and sales channels.

For complete information about SupportWorX service plans
and technical support, please see the Global Support and
Services User Guide at:
http://www.iconics.com/supportworx.

Customer Connection Portal

Get connected with ICONICS by visiting the Customer
Connection Portal for general support, product downloads,
product updates, customer collaboration and product tips
from ICONICS’ engineers and support team. The Customer
Connection Portal features Support Solutions, a Support
Bulletin, product videos, app notes, and whitepapers. The
Support Solutions section addresses essential questions
through the FAQ, Licensing, and a Global Search Engine,
enabling users to find answers quickly and easily. The
Support Bulletin lists your support cases with real-time status
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updates along with popular knowledgebase articles and the
most active forum threads. If users are current on their
SupportWorX software maintenance plan, they are entitled
to free upgrades. Download the latest product updates and
new product releases from the Customer Connection Portal
or sign up for the Beta program to try select features before
they are officially released

Telephone Support

ICONICS support centers are open Monday through Friday,
year round, except for local holidays and ICONICS holidays.
Support handles calls on a first-come, first-served basis
during the business hours below.

Americas (United States): 8:00 AM - 6:00 PM

1-508-543-8600 Eastern Standard Time
Europe (Czech Republic): 9:00 AM - 5:00 PM

+ 420-377-183-420 European Central Time
Asia Pacific (Australia): 9:00 AM - 5:00 PM
+61-2-9605 1333 Australian Eastern Time

Please have the following available when you call:

Your SupportWorX Plan Number.

A PC available for tests and diagnostics.

A clear understanding about the issue.

The version of your OS and the ICONICS product(s).
OPC server or relevant third-party software info.

Note: Go to
https://getconnected.iconics.com/ICONICS/Support/GetSupp

ort.aspx to contact our Technical Support department.

Email Support
The ICONICS support center email addresses are:

North America: Support@ICONICS.com
Europe: EuropeSupport@ICONICS.com
Pacific Rim: PacificRimSupport@ICONICS.com
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Please include your SupportWorX Plan Number when
sending your message. Email requests will be answered on
a first-come, first-served basis typically the same day.
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Global Support Offices

Americas
+1 508 543 8600

¥ support@iconics.com

Asia Pacific
+612 9605 1333

¥ pacificrimsupport@iconics.com

Europe
+420 377 183 420 (Czech Republic)
+49 2241 16 508 0 (Germany)

¥ europesupport@iconics.com

To open a support case, please visit
’P our Customer Connection Portal at % ’
getconnected.iconics.com.

For more, visit www.iconics.com
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